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ComponentOne Foxy for ASP.NET
Overview

Style your Studio for ASP.NET controls effortlessly using our new visual style editor, Foxy & Getting Started
for ASP.NET. With Foxy for ASP.NET, you can edit a Studio for ASP.NET control’s pre-

existing visual styles or create your own theme from scratch. Foxy for ASP.NET is versatile: - Basics (page 13)

you can easily edit CSS properties from a Ribbon interface and a properties grid, or you can - User Interface
roll up your sleeves and stick your hands directly into the CSS source code. (page 19)

It doesn’t matter how you choose to go about it because Foxy for ASP.NET makes CSS - Task-Based Help
editing painless with a real-time preview of each change you make. Don’t like the width of that (page 53)

header? Erase that property setting and tell your text to try on a different size. Foxy for
ASP.NET makes it simple to create custom visual styles with just a little creativity and a few
mouse clicks.

What's New in Foxy for ASP.NET

This documentation was revised for 2010 v1 on March 4, 2010.

¢ Tip: A version history containing a list of new features, improvements, fixes, and changes for each product
is available in HelpCentral at http://helpcentral.componentone.com/VersionHistory.aspx.

New Features
The following new features have been added to Foxy for ASP.NET:

o Foxy for ASP.NET has 10 new visual styles for you to customize. The new styles are Azure,
BureauBlack, Evergreen, ExpressionDark, Office2007Black, Office2007Blue, Office2007Silver,
RainierOrange, RainierPurple, and Windows7. For more information about these visual styles, see

Available Visual Styles (page 13).
o Foxy for ASP.NET now features dockable panes.

Installing Foxy for ASP.NET

The following sections provide helpful information on installing Foxy for ASP.NET.

Foxy for ASP.NET Setup Files

Foxy for ASP.NET is installed by default with ComponentOne Studio for ASP.NET. Studio for ASP.NET
installation program will create the following directory: C:\Program Files\ComponentOne\Studio for
ASP.NET. This directory contains the following subdirectories:

C1WebUi\VisualStyles Contains all external file themes.

C1WebUi\FoxyVSD\Bin Contains the .exe file and Help file for Foxy for ASP.NET.
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By default, the custom visual styles created in Foxy for ASP.NET will be saved to the following directory:
Windows XP C:\Documents and Settings\[User]\My Documents\C1FoxyVSD

Windows 7/Vista C:\Users\[User]\Documents\C1FoxyVSD

System Requirements
System requirements for ComponentOne Studio for ASP.NET components include the following:

Operating Systems: Windows® 2000

Windows Server® 2003
‘Windows Server 2008

Windows XP SP2

Windows Vista™

Windows 7
‘Web Server: Microsoft Internet Information Services (IIS) 5.0 or later
Environments: .NET Framework 2.0 or later

Visual Studio 2005 or Visual Studio 2008
Internet Explorer 6.0 or later
Firefox® 2.0 or later
Safari® 2.0 or later
Disc Drive: CD or DVD-ROM drive if installing from CD

Uninstalling Foxy for ASP.NET
Foxy for ASP.NET is installed with Studio for ASP.NET. To uninstall Studio for ASP.NET:

1. Open Control Panel and select the Add or Remove Programs (Programs and Features in Windows
Vista/7).

2. Select ComponentOne Studio for ASP.NET and click the Remove button.

3. Click Yes to remove the program.

End-User License Agreement

All of the ComponentOne licensing information, including the ComponentOne end-user license agreements,
frequently asked licensing questions, and the ComponentOne licensing model, is available online at
http://www.componentone.com/SuperPages/Licensing/.

Technical Support

ComponentOne offers various support options. For a complete list and a description of each, visit the
ComponentOne Web site at http://www.componentone.com/Support.

Some methods for obtaining technical support include:

e  Online Support via HelpCentral
ComponentOne HelpCentral provides customers with a comprehensive set of technical resources in the
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form of FAQs, samples, Version Release History, Articles, searchable Knowledge Base, searchable Online
Help and more. We recommend this as the first place to look for answers to your technical questions.

Online Support via our Incident Submission Form

This online support service provides you with direct access to our Technical Support staff via an online
incident submission form. When you submit an incident, you will immediately receive a response via e-
mail confirming that you've successfully created an incident. This email will provide you with an Issue
Reference ID and will provide you with a set of possible answers to your question from our
Knowledgebase. You will receive a response from one of the ComponentOne staff members via e-mail in
2 business days or less.

Peer-to-Peer Product Forums and Newsgroups

ComponentOne peer-to-peer product forums and newsgroups are available to exchange information, tips,
and techniques regarding ComponentOne products. ComponentOne sponsors these areas as a forum for
users to share information. While ComponentOne does not provide direct support in the forums and
newsgroups, we periodically monitor them to ensure accuracy of information and provide comments
when appropriate. Please note that a ComponentOne User Account is required to participate in the
ComponentOne Product Forums.

Installation Issues

Registered users can obtain help with problems installing ComponentOne products. Contact technical
support by using the online incident submission form or by phone (412.681.4738). Please note that this
does not include issues related to distributing a product to end-users in an application.

Documentation

ComponentOne documentation is installed with each of our products and is also available online at
HelpCentral. If you have suggestions on how we can improve our documentation, please email the
Documentation team. Please note that e-mail sent to the Documentation team is for documentation
feedback only. Technical Support and Sales issues should be sent directly to their respective departments.

Note: You must create a ComponentOne Account and register your product with a valid serial number to obtain
support using some of the above methods.

Redistributable Files

Foxy for ASP.NET is developed by ComponentOne LLC. You may distribute the following output files, royalty

free:

Any file generated by Foxy for ASP.NET within an output subdirectory relative to a Foxy for ASP.NET
project file.

You may not redistribute any file not cited above.

About This Documentation

Acknowledgements

Microsoft, Windows, Windows Vista, and Visual Studio are either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.

ComponentOne

If you have any suggestions or ideas for new features or controls, please call us or write:

Corporate Headquarters

ComponentOne LLC
201 South Highland Avenue
3" Floor
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ComponentOne Doc-To-Help

This documentation was produced using ComponentOne Doc-To-Help® Enterprise.

Key Features

The following are some of the main features of Foxy for ASP.NET that you may find useful:
e  Fluent User Interface

Foxy for ASP.NET features an Office 2007-like Ribbon user interface that allows you to explore the
functionality of the application without having to navigate through a series of menus.

e WYSIWYG CSS Editing
Foxy for ASP.NET’s WYSIWYG editor allows you to see what your style looks like before you go through the
hassle of loading it onto your control.

o Edit Pre-Existing Visual Styles

Foxy for ASP.NET includes several visual styles for over 20 of Studio for ASP.NET’s controls. Choose
from ArcticFox, Office2007Black, Office2007Blue, Office2007Silver, Vista, or VistaBlack, Windows 7,
and Azure and then use that pre-existing style as the basis for your custom visual style.

e  User Flexibility

Style elements using the Ribbon interface, the CSS Properties grid, or by hand. With Foxy for ASP.NET,
you can write as little or as much CSS as you want.

Quick Start

In this quick start tutorial, you will use Foxy for ASP.INET to create custom visual style for a vertical C1ToolBar
control and then, in Visual Studio, apply your custom style to the C1ToolBar control. Before you begin this
tutorial, you may want to familiarize yourself with the Foxy for ASP.NET interface by reviewing the Foxy for
ASP.NET Basics (page 13) section of this help file.

Step 1 of 4: Creating the Project

In this step, you will open the Foxy for ASP.NET application and create a new custom visual style project.
Complete the following steps:
1. Launch the Foxy for ASP.NET application.
Foxy for ASP.NET opens with the Welcome to Foxy for ASP.NET screen in focus.
2. Inthe Welcome to Foxy for ASP.NET screen, click New Visual Style.
The New VisualStyle dialog box opens.
3. Click the drop-down arrow and select VistaBlack.
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& New VisualStyle

@ Mew from Existing VisualStyles

M
Included VisualStles

ArcticFox

Cffice2007Black

Cffice2007Blue

Cffice 2007 Silver

Vista

C1Editor
C1BEpander

[¥] C1FormDecorator

4. Clear the C1Menu check box. You're clearing C1Menu because you’re only going to work in C1ToolBar
in this tutorial.

4 New VisualStyle

@ Mew from Existing VisualStyles

| VistaBlack -

Choose Controls:
Select Al

[E] C1Menu
C1ToolBar

5. Inthe Name field, enter "TutorialStyle".

Name:  TitorialStyle

6. Click OK to close the New VisualStyle dialog box.
The TutorialStyle project appears in the VisualStyles pane underneath Custom VisualStyles.




Custom VisualStyles p
[ TutoralStyle

Step 1 of 4 Completed @ & & &

In this step, you created a new Foxy for ASP.NET project. In the next step, you will modify the C1ToolBar
control’s border style and border width.

Step 2 of 4: Modifying the ToolBar Control's Border Style

In the last step, you created a visual style project based on the for the C1ToolBar control using the pre-existing
VistaBlack visual style as a base for your project. In this step, you will modify the style and width of the border
that surrounds the C1ToolBar control when the control is in a vertical orientation.

Complete the following steps:
1. Under Custom VisualStyles, expand the TutorialStyle node to reveal the C1ToolBar node.
2. In the treeview, select C1ToolBar.

C1ToolBar's elements appear in the control pane and a preview of its visual style appears in the design
pane.

LiToolBar B X1 TutorislStyle-C1ToclBar | Start
Y4 Horzontal
T Vartical

EBtn .'_l'n-.l'lt".'-.-:d -'_|'|=-.;|.|_-;:i ﬂl"--Jt'!!:'l'll nate | DipChanlist = TGrpl Grpl | Grp? Grp2

3. Expand the Orientation node.

4. Expand the Vertical node to reveal the elements that comprise a vertically oriented C1ToolBar control.




C1ToolBar o =

"'__.;'r Horizontal
s T Vertical

“',.Jr Control
“',.Jr Button
“',.Jr CheckButton
“',.Jr Dirop Dowen List
“',.Jr SplitButton

| Separator
“',.Jr Group

You are choosing Vertical because this tutorial only calls for you to modify the style that is applied to a
vertical C1ToolBar control. If you wanted to modify the style of a horizontal C1ToolBar instead, you’d
just select Horizontal and then complete the same steps.

5. In the treeview, select the Control node.

C1ToolBar o o=
"'_,J Horizontal

4 ¥ Vertical
¥ 4 Button
“',,J CheckButton
“',.J Dirop Dowen List
“',.J Split Buttan
_| Separator
“',.J Group

6. Under the Home tab and in the Border group, click the border-style drop-down arrow and select Dashed
from the list.




CEELDE

W Home Typography Box Layout Background

=R 1 - -] o o
]
Farit -
| . - [ 2
Fs
Clip_. Background dashed L}
dotted
C1ToolBar 1 X | VistaBlack-Custor
i double
4 | g ClToolbar expand all + 3
_‘J Orientation groove
Btn ||| [l Unche hidden
inset
none
outset -
\Bitn|

7. Inthe border-width text box, enter "4".

B3 v px -
1= = "1 &a
Border !

Note: Make sure that px is selected in the drop-down list.

Step 2 of 4 Completed @ & & &

In this step, you modified the border style and width for a vertical C1ToolBar. In the next step, you will modify
the C1ToolBar control’s background color and border color.

Step 3 of 4: Changing the Colors of C1ToolBar’s Background and Border

In the last step, you modified the style and width of the border that appears surrounds a vertical C1ToolBar
control. In this step, you will modify the background color and border color for the vertical C1ToolBar control.

Complete the following steps:

1. In the control pane, make sure that the Control node is still selected.




C1ToolBar B x
g "",.J Horzontal
4 ¥ Verical

+ ¥ Button

: ""_.J CheckButton

: “"_.J Dirop Diown List

: “"_.J Split Button

| Separator

: “"_.J Group

Click the Home tab to reveal its groups of commands.

In the Background group, click the color picker drop-down arrow and select red.

aund

P |T| 3 7|
navy -h
olive

purple ichkground
'staBlack-C red Bar | Star
silver
teal

white

yellow -

In the Border group, click the color picker drop-down arrow and select yellow.




E] 4 - lpe -

) dashed - | =] 2 -
F.
Borg "2V L
alive I
ToolBar VistaBli E=
purple
red
gilver
teal
white
yellow l: -

In the design pane, the vertical C1ToolBar will appear as follows:

Btn

Bl Unchecked
Checked

ﬂ Indeterminate

DrpDwnlist =

Grpl
Grpl
Grpd
Grpd

splitBtn -

5. On the Foxy for ASP.NET toolbar, click the save button Il to save your project.
Step 3 of 4 Completed @ & & &

In this step, you changed the background color and border color and saved your project. In the next step, you will
add your custom visual style to the C1ToolBar control in Visual Studio.

Step 4 of 4. Adding the Custom Visual Style to an ASP.NET Control

To add a custom visual style, complete the following:

Part I: Create a Visual Studio Project with a C1ToolBar Control

10



Complete the following steps:

1
2
3.
4
5

8.

Open Visual Studio 2005 or Visual Studio 2008.

Create an AJAX-Enabled ASP.NET Web site project.

Click the Design button to enter Design view.

From the Toolbox, add a C1ToolBar control and a ScriptManager control to your project.

Click the C1ToolBar control’s smart tag ((H) to open the C1ToolBar Tasks menu and then click Edit
ToolBar.

The C1ToolBar Designer Form opens.

In the C1ToolBar Designer Form’s properties grid, set the C1ToolBar control’s Orientation property to
Vertical.

E Behavior &
AutoPostBack Falze
ClWebControlsPath  ~/ClWebContrels/
Enabled True
EnableTheming True
Enableliewstate True
Crientation Vertical
SkinlD
TrrlTim

a

&
On the C1ToolBar Designer Form'’s toolbar, click the Add Child Item button | three times to add
three buttons to the toolbar.

Click OK to close the C1ToolBar Designer Form.

Part II: Add the Custom Visual Style Files to the Visual Studio Project

Complete the following steps:

1.

In order to add a custom visual style to your project, you must first create new folders. To do this, follow

these steps:

a. In the Solution Explorer window, right-click on your project to open its context menu and select New
Folder. Name the new folder "VisualStyles".

b. Add anew folder underneath the newly created VisualStyles folder and name it "TutorialStyle".

¢. Add another folder under the TutorialStyle folder that you made in the last step and name it “C1ToolBar”.
Your folder hierarchy will match the following image:

. [ VisualStyles
&~ [ TutorialStyle
‘. [ C1ToolBar

Add the custom .css file to the project by completing the following steps:

a. Right-click the C1ToolBar folder and select Add Existing Item to open the Add Existing Item dialog
box.

b. Navigate to the location of the TutorialStyle project, select the CSS file, and click OK to add the file to the
project folder. If you kept the default installation settings for Foxy for ASP.NET, your project folder will
be located in one of the following directories:

o nXP:

11



C:\Documents and Settings\[User] \My Documents\C1FoxyVSD\TutorialStyle
e InVista:

C:\Users\[User]\Documents\C1FoxyVSD\TutorialStyle

3. Add the custom visual style’s images by completing the following steps:

a. Add a folder named "Images" underneath the C1ToolBar folder. The folder hierarchy resembles the
following:

= [ VisualStyles
. B [ TutorialStyle
S [ ClToolBar
4. [ Images
... A} styles.css

b. Right-click the Images folder to open its context menu and then select Add Existing Item to open the Add
Existing Item dialog box.

c. Navigate to the location of the TutorialStyle project (see step 2b for the location) and open the Images
folder.

d. Select all of the project’s images and then click OK to add the images the Images folder.
Part III: Adding the Custom Visual Style to C1ToolBar
Complete the following steps:

1. Right-click the C1ToolBar control to open its context menu and then select Properties.
2. The Properties window opens with the C1ToolBar control’s properties in focus.

3. Set the following C1ToolBar properties:
o Set the UseEmbeddedVisualStyles property to False.
o Set the VisualStyle property to “TutorialStyle”.
e  Set the VisualStylePath property to “~VisualStyles”.

ACCESSRE)Y
Tablndex 0
=
CssClass
Height
UseEmbeddedVisualStyles  False
YisualStyle TutorialStyle

YisualStylePath ~VisualStyles
Width

4. Press F5 to build the project.
Step 4 of 4 Completed " " " &

Congratulations — you have completed the Foxy for ASP.NET quick start tutorial! The result of this project will
resemble the following:

12



|'1

@ Untitled Page - Moxilla Firefox | = [ B | 3 |

File Edit View History Bookmarks Tools Hel
p C fa (L[ntvy -

£ Most Visited $® Getting Started »

ToolBarButtonl

ToolBarButtond

ToolBarButtons

Done

Foxy for ASP.NET Basics

This section details a few of the things you may need to know before using the Foxy for ASP.NET application.

Available Visual Styles

The following visual styles are available in Foxy for ASP.NET:
ArcticFox

The following is an example of the ArcticFox visual style on a Cl1Accordion control.

Proteus

Awards

From Wikipedia, the free encyclopedia

The ArcticFox visual style is available for all Studio for ASP.NET controls.
Azure

The following is an example of the Azure visual style on a C1Calendar control.

13
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The Azure visual style is only available for the C1Calendar control.
BureauBlack

The following is an example of the BureauBlack visual style on a C1Accordion control.

[proteus |
Awards i

| From Wikipedia, the free encyclopedia

The BureauBlack visual style is available for the Cl1Accordion, C1Expander, C1HeaderContentControl, and
C1NavPanel controls.

Evergreen

The following is an example of the Evergreen visual style on a C1Accordion control.

Proteus

Awards

From Wikipedia, the free encyclopedia

The Evergreen visual style is available for the C1Accordion, C1Expander, C1HeaderContentControl,C1Menu,
and C1NavPanel controls.

ExpressionDark

The following is an example of the ExpressionDark visual style on a C1Accordion control.

Proteus

Frar 1edia, the fr
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The ExpressionDark visual style is available for the Cl1Accordion, C1Expander, C1HeaderContentControl, and
C1NavPanel controls.

Office 2007Black

The following is an example of the Office2007Black visual style on a C1Accordion control.

Proteus

Awards

From Wikipedia, the free encyclopedia

The Office2007Black visual style is available for all Studio for ASP.NET controls.
Office 2007Blue

The following is an example of the Office2007Blue visual style on a C1Accordion control.

Proteus

Awards

From Wikipedia, the free encyclopedia

The Office2007Blue visual style is available for all Studio for ASP.NET controls.
Office 2007Silver

The following is an example of the Office2007Silver visual style on a C1Accordion control.

Proteus

Awards

From Wikipedia, the free encyclopedia

The Office2007Silver visual style is available for all Studio for ASP.NET controls.

RainierOrange

The following is an example of the RainierOrange visual style on a C1Accordion control.
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Proteus

Awards
e

| From Wikipedia, the free encyclopedia |

The RainierOrange visual style is available for the C1Accordion, C1Expander, and C1HeaderContentControl
controls.

RainierPurple

The following is an example of the RainierOrange visual style on a C1Accordion control.

| Awards |

| From Wikipedia, the free encyclopedia |

The RainierPurple visual style is available for the C1Accordion, C1Expander, and C1HeaderContentControl
controls.

Vista

The following is an example of the Vista visual style on a C1Accordion control.

Proteus ‘

‘ Awards ‘

From Wikipedia, the free encyclopedia

The Vista visual style is available for all Studio for ASP.NET controls.
VistaBlack

The following is an example of the VistaBlack visual style on a C1Toolbar control.

Btn|| I Unchecked || Bl Checked || B Indeterming

The VistaBlack visual style is only available for the C1Menu and C1Toolbar controls.
Windows7

The following is an example of the Windows7 visual style on a C1Accordion control.
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Proteus

Awards

From Wikipedia, the free encyclopedia

The Windows7 visual style is available for the following controls:

Controls
ClAccordion
ClCalendar
C1ComboBox
C1Expander
Cl1FormDecorator
C1GridView
ClHeaderContentControl
ClInput

ClMenu
C1NavPanel
C1ProgressBar
C1Schedule
Cl1TabControl
C1TabStrip
ClToolBar
ClUpload

¢ Tip: If you'd like to see information regarding a specific control, you can view its NetHelp file, which is
available in the C:\Program Files\ComponentOne\Studio for ASP.NET\H2Help directory or online at

HelpCentral.

Control Styling Concepts

Currently, you can style over twenty Studio for ASP.NET controls using Foxy for ASP.NET (see Available
Visual Styles (page 13) for a complete list). Each control is broken apart into its own unique set of elements. When
you open each control in Foxy for ASP.NET, you will see these elements in the treeview of the control pane (see
Control Pane (page 20)). C1Window, for example, begins with a top-level element of C1Window (representing
the entire control) which then has four sub-elements: Header, Content, Footer, and Resizer. Those sub-elements
are then segmented into smaller elements. For instance, the Header element is broken up into the Left, Right, and
Content sub-elements. And it continues. If you expand the Left, Right, and Content sub-elements, you’ll see that
they are then dissected into more elements, each of which represents a certain behavior of the control. The image
below illustrates these elements:
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4 "‘,._J C1Window
4 ";._,} Header

F] “"_‘._‘} Left
| UnFocus
| UnFocusMaximized
_| Focus
_| FocusMaxdmized

4 %4 Right
| UnFocus
| UnFocusMaximized
_| Focus
_| FocusMaxdmized

4 “',;.4' Contert
| UnFocus
| UnFocusMaximized
_| Focus
_| FocusMaxdmized
_| ClosedMinimized

] lzan
& J TitleLeft

Adding Custom Visual Styles to Control’s

To add a custom visual style to a Studio for ASP.NET control (see Available Visual Styles (page 13) a list of
available visual styles), you will have to add the .css file and images you used to your Visual Studio Web project.
These instructions illustrate the process of adding a custom visual style using the C1MultiPage control as an
example.

Before you add your .css file and images, you will have to create a hierarchy of folders, the last of which will
contain your visual style files. On the top-level of your project, create a folder named "VisualStyles". Underneath
the VisualStyles folder, create a sub-folder bearing the theme name (such as "CustomStyle"), and then, beneath
that, create a sub-folder named "C1MultiPage". The image folder and .css file should be placed underneath the
C1MultiPage folder. The result will resemble the following image:

_: Solution 'AJAXEnabledwebsited (3)' (1 pro
= [ C\WebsiteProjects\AJAXEnabler
3 App_Data
& Bin
= |7 Visualstyles
= & CustomStyle
= [ CiMultiPage
L3 Images
Al styles.ces
|2=] Detault, aspx
licenses. licxk
258 Weh.config

This structure of these folders is very important; C1MultiPage will always look for the
~/VisualStyles/[StyleName]/C1MultiPage/styles.css path, as it is the default visual style path for the control.
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Once the .css file and images are in place, set the VisualStylePath property to the path of the first folder
(~/VisualStyles), set the UseEmbeddedVisualStyles property to False, and then set the VisualStyle property to the
custom theme name.

User Interface

Foxy for ASP.NET’s features a sleek, modern interface consisting of three panes, a Ribbon interface, and a status
bar. Each time you open Foxy for ASP.NET, you will be greeted with the Welcome to Foxy for ASP.NET page,
which allows you to initiate visual style projects immediately after opening the application.

The following sections provide additional information regarding the Welcome to Foxy for ASP.NET page, the
panes, the Ribbon interface, and the status bar.

Welcome to Foxy for ASP.NET Page

The Welcome to Foxy VSD page has two sections: Getting Started and Recent VisualStyles.

Welcome to foxyfor ASPNET

Getting Started
@ L ke Lo J l
' 25 oy ©J
Mew Open Import Export
Visualityle | VisualStyle || VisualStyle | WisualStyle
Recent VisualStyles

7 ArcticFox-Costom7-C 1Calendar

There are four buttons under Getting Started: New VisualStyle, Open VisualStyle, Import VisualStyle, and
Export VisualStyle. These commands, which also appear under the Foxy for ASP.NET button, launch dialogs
that are used to create and move visual styles.

The Recent VisualStyles list will include visual styles that were previously opened in Foxy for ASP.NET,
regardless if whether or not they are in the default VisualStyle folder or in another location. This section will also
appear under the Foxy for ASP.NET button.

You can always return to this page by clicking the Start tab in the design pane.
For more information regarding the dialog boxes mentioned in this section, see the following topics:

e New VisualStyle Dialog Box (page 29)

e Browse For Folder Dialog Box (Open VisualStyle) (page 30)

e Browse For Folder Dialog Box (Import VisualStyle) (page 31)

e Export VisualStyle Dialog Box (page 32)
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Panes

Foxy for ASP.NET contains three dockable panes: the control pane, the design pane, and the VisualStyles/CSS
Properties pane. The third pane, VisualStyles/CSS Properties, is actually two panes in one: it defaults to the
VisualStyles pane but can be switched to the CSS Properties pane by clicking the CSS Properties tab at the

bottom of the pane.

The following image diagrams the default locations of each pane.

Control/HTMLHierarchy Design Visual Styles/CSS Properties
Pane Pane Pane
\ApDoard poragr Lolor carting
C1Slider * X ||| ArcticFox-Custom5-C1Slider | A 4 b x||Visualstyles X
4 71 Cl15ider expandall + 2| Included VisualStyles =
+ €4 Orientation MNormal = 3 ArcticFox -~
; 1 S - Office2007Black B
o o [ Office2007Blue "':‘
Disabled [ Office2007Silver
e — & e 1 Vista -
Custom VisualStyles =
C55 View - C15hider o o]
C1Sider_ArcticFox Custom5-C1Horizontal » e i
F ¥ C15plitter i
moz-user-select: none; — d “'_.J C1TabControl L
font-size: Ipx; - ¥ C1TabStrp -
flcuat:l!af't; | e |
text-align: left;
C1Slider | HtmlHisrarchy E'ic_ltE_EEEt_: «|| Visualstyles | CSS Properties
5—'| 03 i“ﬁ .

Foxy for ASP.NET's panes are dockable. To redock a pane, click its header and drag it to another area. When
your cursor reaches a dockable area, a bounding box will appear, and then you can just release the mouse button to
dock the pane. If you release the mouse button in an area where no bounding box appears, the pane will float.

The following topics describe each pane in detail.

Control Pane

The control pane contains a treeview that lists all of the CSS parts contained within the currently selected control.
By default, this pane will be empty; you will have to choose a control from the VisualStyles pane. You can add the
control from either the Included VisualStyles list or the Custom VisualStyles list. Please note that you can only
edit control’s added from the Custom VisualStyles list; controls added from the Included VisualStyles list will be

read-only.

At startup, the control pane is empty and will appear similar to the following:
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Contral a3 =

Control HtmlHierarchy

‘When the control pane is loaded, it appears similar to the following:

ClAccordion R =

4 7 ClAccordion expandal +
4 “',.Jr Expand Direction
“",.4' Bottom
¢4 Top
-«-JJ Left
4 “"_,Jr Right
4 "'_.J AccordionPanel
“",,4' Header
“",,4' Cortent
4 "'_.J Digabled
_| HeaderPanel
| HeaderContert

Cliccordion | HtmlHierarchy

Note that the control pane will adopt the name of control when it is loaded.
To Load a Control from Included VisualStyles
To add a control from the Included VisualStyles, complete the following steps:

1. Navigate to the VisualStyles pane.

2. Under Included VisualStyles, expand the node next to the visual style you want to preview.
The node expands, revealing the controls using that visual style.
3. Complete one of the following:

e  (Click the control name.




OR
e Right-click on the control name to open its context menu and then select View in Foxy VSD.
The selected control appears in the control pane.
To Load a Control from Custom VisualStyles
To add a control from the Custom VisualStyles, complete the following steps:
1. Navigate to the VisualStyles pane.
2. Under Custom VisualStyles, expand the node next to the visual style you want to edit.
The node expands, revealing the controls using that visual style.
3. Complete one of the following:
e Click a control name.
OR
e Right-click on a control name to open its context menu and then select View in Foxy VSD.
The selected control appears in the control pane.

Once you’ve added the control to the control pane, you can expand the node next to the control’s name to see its
list of its parts. If a part is comprised of multiple parts, there will be an expandable node next to that part name as
well. You can expand all nodes by clicking expand all.

If you added an editable control visual style to the control pane, you can begin the editing process by clicking on
one of the control’s parts and then editing the CSS properties associated with that part using the Ribbon, CSS view
or the CSS Properties pane.

HtmlHierarchy Pane

You can access the HtmlHierarchy pane from the right pane of Foxy for ASP.NET. By default, that pane holds
control elements, but you can easily switch it over to HtmlHierarchy by clicking the HtmlHierarchy tab at the
bottom of the pane. The HtmlHierarchy pane appears as follows:

HtmlHigrarchy o =
4 ";._Jr <HTML xming="http ./ www w3.org/
4 <HEAD>

4 ¢ <BODY>

4 %, <FORMid=form1 method=pc
T <DIV>

_| <SCRIPT type=text javascr

_| <SCRIPT type=text javascr

_| <SCRIPT type=text javascr

_| <SCRIPT type=text javascr

_| <SCRIPT type=text javascr

_| <SCRIPT type=text javascr

_| <SCRIPT type=text javascr
¢4 <DIV:

_| <SCRIPT type=text javascr

4 [0 k
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The HtmlHierarchy pane provides the hierarchy of HTML elements that make up a control's style. When you
scroll over an HTML element in the hierarchy, a ToolTip will appear with the HTML markup and/or Javascript
that appears on that level.

HtmlHierarchy B X VistaBlack-Custom?-
a ¥ <HTML xmins="http://www w3.0rg/1999/dtml

[FI - .

ga <HEAD> Horizontal Menu

a ¥ <BODY>
4 ¥ <FORM id=form1 method=post name=fc m

tfm ki sl Mppm
<SCRIPT type=text javascript =

—| A<I[CDATA]

— var theFom = document forms[form17;
L if {theForm) {

| theForm =document form1;

—] function __doPostBacki{event Target, eventArgument) {

— i {theFom.onsubmit | #heForm.onsubmit() 1= false)) { y
theForm.__ EVENTTARGET value = event Tanget; iH
theForm.__ EVENTARGUMENT value = eventArgumert; |

} theFom submit();

</SCRIPTS

Design Pane
The design pane provides a preview and/or the CSS code for the selected control’s visual style.
Design Pane Tabs

When you are working on a project, the top of the design pane will also contain a series of tabs. By default, only
one tab — Start — appears, but additional tabs will open each time you select a control from the VisualStyles pane.
Each tab contains the name of the visual style and control that is associated with it. For example, a tab containing
a preview for the C1Window control’s Office2007Blue visual style will be named Office2007Blue-C1Window.

o
To close one tab, select a tab and then click the "= button on the right side of the tab bar. To close all tabs, click the
x| on the right side of the tab bar.
Design Pane Views

The design pane has three possible views: Design view, Source view, and Split view. Split view is the default view,
but you can easily switch between views using buttons on the status bar. Each view is illustrated below.

Design View

This view displays the visual style’s content in a What-You-See-Is-What-You-Get (WYSIWYG) format. It
provides a real-time simulation of how the content will appear when published or printed.

The following image shows the text editor in Design view:
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1 WindowVisual Style
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1| TI] 3

To open Design view, click the Design button = on the status bar.
CSS View

This view provides a hand-coding environment for writing and editing CSS. While CSS view is commonly used by
those who want to manually enter CSS, users can still use the Ribbon interface or the CSS Properties pane to set
CSS properties.

The following image shows the text editor in CSS view:

Cffice2007Black-Custom1-C 1Window ] x
/Dock horzontally™/ -
LC1Window_Cffice2007Black-Custom 1 D
1

float 1eft;
i

Hnvisible tems™/
LCTWindow_Office2007Black-Custom1 Clwinvisible
1

display:none;
i

C1Window_Cffice2007Black-Custom1 clqesizehandle
1| ] | 3

To open CSS view, click the CSS button <] on the status bar.
Split View (default)

This view displays both the Design view and CSS view in the Design pane. When you invoke this view, the editor
splits the text editor into two vertical sections; the top section features the Design view, while the bottom section
features the CSS view. This view is useful because you can see an immediate preview of the content as you edit the
visual style’s CSS.

The following image shows the text editor in Split view:
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To open Split view, click the Split button =l on the status bar.

VisualStyles Pane

The VisualStyles pane holds two lists: Included VisualStyles and Custom VisualStyles. The VisualStyles pane
appears as follows:

\VisualStyles - B x|
Included VisualStyles =
- [ ArcticFox -
- O Azure

I [ BureauBlack

- [ Ewergreen

I [ ExpressionDark
- [ Office2007Black
- [ Office2007BIue

o P s W T il
——

Custom VisualStyles =

a VisualStyle here to begin

VisualStyles CS55 Properties




The IncludedVisualStyles list holds the original visual styles for each control. From the Included Visual Styles list,
you can select a control style to preview in the design pane and control pane, or you can copy a control style to the
Custom VisualStyles pane.

To Preview an Included Visual Style
Complete the following steps:
1. Navigate to the VisualStyles pane.
2. Under Included VisualStyles, expand the node for the visual style you want to preview.
The node expands, revealing the controls that can use that visual style.
3. Complete one of the following:
e  (Click the control name.
OR
e Right-click on the control name to open its context menu and then select View in Foxy VSD.

The selected control appears in the control pane and a preview of the control’s visual style appears in
the design pane.

To Copy an Included Visual Style
Complete the following steps:
1. Navigate to the VisualStyles pane.
2. Under Included VisualStyles, expand the node for the visual style you want to preview.
The node expands, revealing the controls that can use that visual style.
3. Complete one of the following:
e Right-click the control name to open its context menu and then select Copy to Custom.
OR
e  Click the control and use a drag-and-drop operation to place it into the Custom VisualStyles list.
A custom visual style is created under Custom VisualStyles.
To Copy a Custom Visual Style
1. Navigate to the VisualStyles pane.

2. Inthe Custom VisualStyles list, right-click the visual style folder to open its context menu and then select
Copy.

3. Right-click anywhere within the Custom VisualStyles to open the context menu and then select Paste.

A duplicate of the original visual style appears in the Custom VisualStyles list.

CSS Properties Pane

The CSS Properties pane can be accessed from the left pane of Foxy for ASP.NET. By default, that pane holds
the VisualStyles information, but you can easily switch it over to CSS Properties by clicking the CSS Properties
tab at the bottom of the pane. The CSS Properties pane appears as follows:

26



55 Properties - 0 =
| C1Window_Vista-Custom2 ClwHean ~ |

2 |
background  urd({lmages/Title =«
background-att scroll
backgroundco[ | Transparer| =
background-m: ur (Images/Title
background-po rght top
background-e; mo-repeat
= Block
|etterspacing
line-height
teat-align
tent-ndent
vertical-align
white-space
word-spacing
E Border
border
hinrderhnttnm
Visualstyles C5S5 Properties

The CSS Properties pane is similar to the Properties window in Visual Studio. The CSS Properties pane includes
all possible editable CSS options within a grid. To use the CSS Properties pane to modify a theme, create a custom
theme, select the control part you wish to modify, and then use the CSS Properties pane to modify the CSS
properties.

To Edit Visual Styles in the CSS Properties Pane
Complete the following steps:
1. Create a custom visual style project.
2. Inthe VisualStyles pane, click on the control you wish to edit.
The control is loaded into the control pane.
3. Inthe Control pane, expand the node next to the control’s name.
The node expands, revealing the control’s elements.
4. Select the control part you wish to edit.
5. Navigate to the VisualStyles pane (the leftmost pane) and click the CSS Properties tab.
The CSS Properties pane opens.
6. Edit the desired CSS properties.

Ribbon

Foxy for ASP.NET’s Ribbon interface enables you to explore commands without forcing you to navigate through
a hierarchy of menus. The Ribbon interface is a tabbed pane that contains interface elements, such as buttons and
drop-down lists. These interface elements are collected into groups of interrelated or affiliated commands, which
are then arranged into a series of tabs to consolidate similar editing tasks.

Foxy for ASP.NET’s Ribbon contains the Foxy for ASP.NET button, the Quick Access Toolbar, and five tabs.
The Foxy for ASP.NET button opens the application menu, the quick launch toolbar holds common commands
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for quick user access, each of the five tabs contain CSS editing options, and the status bar allows you to choose
between design views. The diagram below illustrates each area of the ribbon interface.

Quick Access TDDIbar—l —Ribbon Tabs

i
| b B R
Foxy for ASP.NET: @ o o -

Button Home Typography Box Layout Background

—_ - - |px

Paste - - |8 -

Clipboard Fort

The sections below provide information about each ribbon element.

Foxy for ASP.NET Button

The Foxy for ASP.NET button is located in the upper right corner of the Foxy for ASP.NET application. When
clicked, it opens the application menu, which appears as follows:

Recent Visual Style

Mew
1 ¢ 4 Vista-Custom2-C1Calendar =
o 17w “_',& Vista-Custom2-C1Accordion [=]
r&7 Open

H Save All

hi
J Close

2] Fomy Options | | X Close Fogy

From the menu, you can select the following commands:
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Command

New
Open
Import
Export
Save
SaveAll

Print
Close

Description

This command opens up New VisualStyle dialog box, which you can use to create a new visual style using an old project or
from scratch.

This command opens the Browse For Folder dialog box, which you can use to open a pre-existing visual style to edit in
Foxy for ASP.NET.

This command opens the Browse For Folder dialog box, which you can use to import a pre-existing visual style to edit in
Foxy for ASP.NET.

This command opens the Export VisualStyle dialog box, which you can use to export one of your visual styles to another
hard drive location.

This command saves the part of the project that is currently opened.

This command saves every part of your current project.

This command prints the contents of the Display pane.

This command closes the menu.

On the left side of the menu are projects that you recently accessed. Recently accessed projects will appear here
regardless if whether they are in the default VisualStyle folder or in another location.

At the bottom of the menu are two buttons, Foxy Options and Close Foxy. Clicking Foxy Options will open a

start dialog box that allows you to edit application options. Clicking Close Foxy will close the application menu.

The sections below detail the dialog boxes that you can open from the application menu.

New VisualStyle Dialog Box

The New VisualStyle dialog box is accessed by selecting the New option on the application menu (see Foxy for
ASP.NET Button (page 28)). The New VisualStyle dialog box appears as follows:
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The New VisualStyle dialog box allows can create a new visual style from one of the pre-existing styles under
Included VisualStyles or from one of the existing styles under Custom VisualStyles.

If the New from Existing VisualStyle radio button is selected, the default naming convention will be [VisualStyle|-
Custom{#]. If the New Blank VisualStyle radio button is selected, the default naming convention will be Untitled-[#/
unless changed by the user. The new visual style will be added to the VisualStyles pane under Custom
VisualStyles.

For task-based help on creating a project, see Creating a Project (page 53).

Browse For Folder Dialog Box (Open VisualStyle)

You can access the Browse For Folder dialog box by selecting the Open option on the application menu (see Foxy
for ASP.NET Button (page 28)). The Browse For Folder dialog box appears as follows:
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The Browse For Folder dialog box is used to open a visual style for editing. This opened visual style will remain in
place; it will not be moved or copied to the default visual style location. The opened visual style will be added to
the VisualStyles pane underneath the Custom VisualStyles list.

For task-based help on opening a project, see Opening a Project (page 55).

Browse For Folder Dialog Box (Import VisualStyle)

The Browse For Folder dialog box is accessed by selecting the Import option on the application menu (see Foxy
for ASP.NET Button (page 28)). The Browse For Folder dialog box appears as follows:
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Select the VisualStyle folder that you want to import and
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The Browse For Folder dialog box is similar to the dialog box that opens when you select the Open option (see
Browse For Folder Dialog Box (Open VisualStyle) (page 30), except it will copy the chosen visual style to the
default location for editing, leaving the existing visual style unchanged. This is useful if you do not want to
overwrite a version of an existing visual style.

For task-based help on importing a project, see Importing a Project (page 56).

Export VisualStyle Dialog Box

The Export VisualStyle dialog box is accessed by selecting the Export option on the application menu (see Foxy
for ASP.NET Button (page 28)). The Export VisualStyle dialog box appears as follows:
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Type the target path for the VisualStyle or click " Browse™:

The Export VisualStyle dialog box is used to export or move one of the pre-existing visual styles from the Included
VisualStyles list or one of the existing visual styles from the Custom VisualStyles list to a new folder. To export the
visual style, you will need to type in a target path or use the Browse button to select a target path.

For task-based help on exporting a project, see Exporting a Project (page 57).

Foxy for ASP.NET Dialog Box

The Foxy for ASP.NET dialog box is accessed by selecting the Foxy Options option on the application menu (see
Foxy for ASP.NET Button (page 28)). The Foxy for ASP.NET dialog box appears as follows:
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From the Foxy for ASP.NET dialog box, you can control the amount of Recent Visual Styles that are displayed
under the Foxy for ASP.NET button and change the Default Visual Style Location. To change the amount of
recent visual styles that appear, use the arrow keys to change the number. To change the default location of the
visual styles, click the Change Default Location link to open the Browse For Folder dialog box, select a new
folder, and click OK.

Quick Access Toolbar

The Quick Access Toolbar, which provides easy access to commonly used functions, is next to the Foxy for
ASP.NET button (see Foxy for ASP.NET Button (page 28)) unless it is moved below the Ribbon using the
Customize Quick Access Toolbar button.

The Quick Access Toolbar appears as follows:

FEEEEDE

The following elements are part of the Quick Access Toolbar:

(1)) Action Description

Element

H Save Saves changes to the currently opened visual style elements.

ﬂ Save All Saves changes to all elements in a visual style project.

) Undo Undo your last action.

f Redo Redo your last undo.

= Customize Quick Launch This button (the arrow on the right) can be used to move the Quick Access Toolbar (select
button Show Above/Show Below the Ribbon), or minimize/maximize the Ribbon

(select/deselect the Minimize the Ribbon check box).
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You can add ribbon items to the quick access toolbar by dragging the item and dropping it
on the quick access toolbar.

Ribbon Tabs

Five tabs — Home, Typography, Box, Layout, and Background — appear along the top of the Ribbon interface.
These tabs are used to consolidate similar CSS editing tasks under one place, thus eliminating the need to search
through a maze of menus to find the appropriate commands. The commands housed under these tabs are used for
WYSIWYG (What-You-See-Is-What-You-Get) CSS editing. The following sections detail each of the five Ribbon
tabs.

Home Tab

The Home tab contains six groups: Clipboard, Font, Background, Border, Dimensions, and Editing. The
commands housed in this tab are basic; if you are new to CSS editing, most of the commands that you use at first
will be grouped under this tab. The Home tab appears as follows:

Cipboand Fort Eackogroand Honder ] Cemarcion

The following topics detail the commands of each group.

Clipboard Group

The Clipboard group resides within the Home tab (see Home Tab (page 35)). The Clipboard tab appears as
follows:

] &
-]

Faste g3

Clipboard

The following image diagrams the commands of the Clipboard group.

UI Element Command Description
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— Paste Applies the contents of the clipboard to the project.

Paste
& Cut Removes the current selection and places it on the clipboard.
-;EI Copy Copies the current selection by placing it on the clipboard.
Font Group

The Font group resides within the Home tab (see Home Tab (page 35)). The following image diagrams the
commands of the Font group.

Font Family Font Size

- -

T&TuB -

Fort

Font Color Font
Color Picker = Weight

The following table details the commands of the Font group.

Command Description

Font Family Allows you to choose the font that will be applied to the text. This sets the font-family CSS property.

Font Size Allows you to choose a size for the text. You can choose the size from the drop-down list, or you can enter a value and
choose a unit of measurement from the drop-down list to the right. This sets the font-size CSS property.

Font Color Allows you to set the color of the text using hexadecimal value. This sets the color CSS property.

Color Picker Allows you to set the color of text using a visual color picker. Once the color is picked, its hexadecimal value will appear
in the Font Color box. This sets the color CSS property.

Font Weight Allows you to set the weight of the font (for example, Bold or Lighter). This sets the font-weight CSS property.

Background Group

The Background group resides within the Home tab (see Home Tab (page 35)). The following image diagrams the
commands of the Background group.

Background Color

- a1
t =

Background

Background Image

The following table details the commands of the Background group.
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Command Description

Background Color Applies a color to the background using a hexadecimal value. This sets the background-color CSS property.

Background Image The background of the chosen element. Clicking the image picker button opens the Open dialog box and allows you
to choose an image for the background. This sets the background-image CSS property.

Border Group

The Border group resides within the Home tab (see Home Tab (page 35)). The following image diagrams the
commands of the Border group.

Border Width

1 - |px l
(L 1 MR
Border F]
Border 5tyle Border Color

The following table details the commands of the Border group.

Command Description

Border Width Sets the width of an element's border. Select from thin, medium, thick, or inherit. You can also specify a value by
selecting (value), choosing a measurement type, and then typing in a number. This sets the border-width CSS property.

Border Style Applies a border style to an element; you can choose from dashed, dotted, double, groove, hidden, inset, none, outset,
ridge, solid, or inherit. This sets the border-style CSS property.

Border Color Applies a color to the border using a hexadecimal value. This sets the border-color CSS property. This sets the border-
color CSS property.

The border group also contains a target button = that you can click to open the Border dialog box. To learn more
about the Border dialog box, see Border Dialog Box (page 37).

Border Dialog Box

The Border dialog box enables you to specify a border style, border width, and border color for the CSS box model.
There are five rows in the Border dialog box — All, Top, Right, Bottom, and Left — and each row represents an area of
the box. Each row allows you to set the Border Style, Border Width, and Border Color for an area of the box. For
example, any properties you set in the All row will be applied to all four lines of the box, whereas any properties you set
in the Top row will only be applied to the top line of the box.
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Below the property settings is the CSS Box Model Preview. The preview provides a preview of how a box and its
elements relate to each other.

To Open the Border Dialog Box
Complete the following steps:
1. On the FoxyVSD Ribbon, click the Home tab.
2. Locate the Border group and then click the target ™ at the lower right corner of the group.
The Border dialog box opens.

Dimensions Group

The Dimensions group resides within the Home tab (see Home Tab (page 35)). This group holds commands for
setting the size of an element. The Dimensions group appears as follows:

E 100 g v

=

ED 23 - px -
Dimensions

The following table details the commands of the Dimensions group.
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UI Element Description

— Allows you to set the width of an element. You can choose one of the options from the commands drop-downs,
=P 100 TR T or you can enter a value and then choose a unit of measurement from the drop-down box to the right of the
control. This sets the width CSS property.
+ Allows you to set the height of an element. You can choose one of the options from the commands drop-downs,
| 1‘..|J 28 i L or you can enter a value and then choose a unit of measurement from the drop-down box to the right. This sets
the height CSS property.

Editing Group

The Editing group, from where you can find or replace text and clear styles, resides within the Home tab (see
Home Tab (page 35)). The Editing group appears as follows:

33 Find ‘ =

. Replace "
“"lg - Colorize | DOMInspectar
¢ Clear Style

Editing
The following table details the commands of the Editing group.

UI Element Description
E?E Find Opens the Find dialog box. For more information on the Find dialog box, see Find Dialog Box (page 39).

a Repl Opens the Replace dialog box. For more information on the Replace dialog box, see Replace Dialog Box (page 40).
4. Replace

<7 Clear Style Clears the currently selected style.

‘ Opens the Hue/Saturation dialog box from where you can adjust a visual style's hue, saturation, lightness, and color.
—_— For more information on the Hue/Saturation dialog box, see Hue/Saturation Dialog Box (page 41).
Colorize
==

The DOMinspector is used to browse the document object model tree. To use the DOM inspector, select the
L'\'Bl DOMlInspector button, navigate to the design pane, and click on an area of a control's style. The DOMInspector will
DO Minspector glow orange when it is selected.

Find Dialog Box

The Find dialog box allows you to find text inside of a CSS style sheet. To use the Find dialog box, switch to either
Source or Split view (see Design Pane (page 23)), select an element in the control pane, and then, under the Home
tab, click the Find button. The Find dialog box will open and appear as follows.
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The Find dialog box consists of the following UI elements:

UI Element

Find what text box

Match case check box
Match whole word check box
Direction Radio

Find Next button

Cancel

Replace Dialog Box

Description

In the Find what text box, enter the text you would like to find.

If the Match case check box is selected, the search will be case sensitive. If unselected, the search will
look for a match in any case.

If the Match whole word check box is selected, the search will only find instances of the text when
it's a whole word rather than a partial word.

Select the Up radio button to search for text up from your current location; select the Down radio
button to search for text down from of your current location.

Click the Find Next button to locate the next instance of the text in the Find what text box.

Click the Cancel button to close the Find dialog box.

The Replace dialog box allows you to locate a specified string and replace it with another string. To use the
Replace dialog box, switch to either Source or Split view (see Design Pane (page 23)), select an element in the
control pane, and then, under the Home tab, click the Replace button. The Replace dialog box will open and

appear as follows:

[ o5 Replace @
Find what: | | Find Mext |
Replace with:
[7] Match case

The Replace dialog box consists of the following UI elements:

UI Element

Description
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Find what text box
Replace with text box

Match case check box

Find Next button
Replace
Replace All

In the Find what text box, enter the text you would like to replace.
In the Replace with text box, enter the text you would like to have replace the original text.

If the Match case check box is selected, the search will be case sensitive. If unselected, the search will look
for a match in any case.

Click the Find Next button to find the next instance of the text in the Find what text box
Click the Replace button to replace the text with the text in the Replace with button.

Click Replace All to replace all instances of the text in the Find what text box with the text in the Replace
with text box.

Hue/Saturation Dialog Box

The Hue/Saturation dialog box allows you to adjust the color of a visual style. To open the Hue/Saturation
dialog box, navigate to the Home tab and click the Colorize button. The dialog box looks as follows:

-

a5l Hue/Saturation |2 ] = |

Hue: 0

U
Saturation: 0

U
Lightness: 0

U
[T] Colorize | < ~

[ feply | [ Cancel

To adjust the hue, saturation, and lightness, use their associated slider bars. To colorize a visual style, select the
Colorize check box and then click the color picker button to open the Hue/Saturation dialog box. Once you have
selected a color from the Hue/Saturation dialog box, you can modify the color by adjusting its hue, saturation,

and lightness.

Typography Tab

The Typography tab contains two groups: Font Style and Paragraph. You can use the commands under this tab to
configure basic typographic setting, such as the font’s style or the paragraph’s letter spacing. The Typography Tab

appears as follows:
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The sections below illustrate the commands of each group of the Typography tab.

Font Style Group

The Font Style group resides within the Typography tab (see Typography Tab (page 41)); commands in this group
allow you to specify font styles, such as whether or not the text will be italic or how far apart the letters will be
spaced. Within the Font Style group are three sections — Font Style, Font Variant, and Text Decoration — that
allow you to change different aspects of a font’s style. The image below diagrams the sections of the Font Style
group.

fortstde: £ N Ob & | |fortvadant: N AB a5

textdecoration: U © & b (I

Fort Style

Each of one of the following tables details the commands of the Font Style group.
Font-Style Section

The commands that modify the font- style property are as follows:

UI Element Name Description
I Italic Sets the font-style CSS property to italic.
N Normal Sets the font-style CSS property to normal.
Ob Oblique Sets the font-style CSS property to oblique.
Inherit Sets the font-style CSS property to inherit. Specifying a value as inherit will cause the
aTaTe) selected element to adopt its parent’s property values.
inherit

Font-Variant Section

The commands that modify the font-variant property are as follows:

UI Element Name Description

N Normal Sets the font-variant CSS property to normal.

AR Small Caps Sets the font-variant CSS property to small-caps.

= Inherit Sets the font-variant CSS property to inherit. Specifying a value as inherit will cause the

selected element to adopt its parent’s property values.
Text-Decoration

The commands that modify the text-decoration property are as follows:

UI Element Name Description
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o Underline

0 Overline

E Line Through
h Blink

@. None

Paragraph Group

Sets the text-decoration CSS property to underline.

Sets the text-decoration CSS property to overline.

Sets the text-decoration CSS property to line-through.

Sets the text-decoration CSS property to blink.

Sets the text-decoration CSS property to none.

The Paragraph Style group resides within the Typography tab (see Typography Tab (page 41)); commands in this
group allow you to specify the text style and alignment of an entire paragraph. The paragraph group appears as

follows:

fﬂ"; letterspacing:

s word-spacing:

-

“ white-space:

=]
¥
]
1
T
L
4
=]

4

testiransform: Ab ab AR [F] S

Paragraph

The table below details the commands of the Paragraph group.

UI Element
AV |etter-spacing:
= word-spacing ;

= -
= 5

e
L]
4

LI

£< white-space:

SO0
inherit

Name

letter-spacing

word-spacing

line-height

text-indent

vertical-align

white-space

capitalize
lowercase
uppercase
none

inherit

left
center

right

Description

Sets the letter-spacing property to normal, inherit, or (value). If you
choose value, enter a value into the text box and then use the drop-down list
to the right to specify a unit of measurement.

Sets the word-spacing property to normal to normal, inherit, or (value). If
you choose value, enter a value into the text box and then use the drop-
down list to the right to specity a unit of measurement.

Sets the line-height property to normal, inherit, or (value). If you choose
value, enter a value into the text box and then use the drop-down list to the
right to specify a unit of measurement.

Sets the text-indent property to either inherit or a (value). If you choose
value, enter a value into the text box and then use the drop-down list to the
right to specify a unit of measurement.

Sets the vertical-align property to baseline, bottom, middle, sub, super,
text-bottom, text-top, top, inherit, or (value). Specifying inherit will
cause the selected element to adopt its parent’s property values. If you
choose value, enter a value into the text box and then use the drop-down list
to the right to specify a unit of measurement.

Sets the white-space property to normal, no wrap, pre, pre-line, pre-
wrap, or inherit. Specifying inherit will cause the selected element to
adopt its parent’s property values.

Sets the text-transform property to capitalize. This setting will capitalize the
first letter of each word.

Sets the text-transform property to lowercase. This setting will set all
letters to lowercase.

Sets the text-transform property to uppercase. This setting will set all
letters to uppercase.

Sets the text-transform property to none. The text is presented as it appears
in the HTML.

Sets the text-transform property to inherit. Specifying inherit will cause
the selected element to adopt its parent’s property values.

Sets the text-align property to left. Text will align to the left of the page,
leaving a jagged edge on the right.

Sets the text-align property to center. Text will align to the center of the
element, leaving a jagged edge on the left and right.

Sets the text-align property to right. Text will align to the right of the
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element, leaving a jagged edge on the left.

= justify Sets the text-align property to justify. Text will align equally the both sides
_ of the element, creating a smooth column of text.
inherit Sets the text-align property to inherit.
[
inherit
Box Tab

The Box tab is used to make changes to the CSS box model. The tab contains two groups: Padding and Margin,
and both groups have an associated dialog box from where you can make more advanced modifications. The Box
tab appears as follows:

{4 Custom padding .3 Custom margin

Padding Margin

The following sections detail the two Box tab groups and their respective dialog boxes.

Padding Group

The Padding group resides within the Box tab (see Box Tab (page 44)). This group allows you to define the space
between the border and the content. The Padding group appears as follows:

bl [+ S

& Custom padding

Padding

The table below details the commands in the Padding group.

UI Element Name Description
Padding Sets the padding property to inherit or (value). If you choose value, enter a value into the text
i box and then use the drop-down list to the right to specify a unit of measurement.
E Custom padding Custom Padding Click the Custom Padding button to open the Padding dialog box. For more information

regarding the Padding dialog box, see Padding Dialog Box (page 44).

Padding Dialog Box

The Border dialog box enables you to specify the width of the padding for the CSS box model. There are five rows in
the Border dialog box — All, Top, Right, Bottom, and Left — and each row represents an area of the box. Each row
allows you to set the width of a specific area in the box. For example, setting the property in the All row will apply the
setting to every area of the box, whereas setting the property in the Top row will only add that padding setting to the top
area of the box.
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Below the property settings is the CSS Box Model Preview. The preview provides a sample of how a box and its
elements relate to each other.

To Open the Padding Dialog Box
Complete the following steps:
1. On the Foxy for ASP.NET Ribbon, click the Box tab.
2. Locate the Padding group and then click the Custom Padding button.
The Padding dialog box opens.

Margin Group

The Margin group resides within the Box tab (see Box Tab (page 44)). This group allows you to specify the area of
clearance around the border. The Margin group appears as follows:

ﬂ Custom margin

Margin

The table below details the one command in the Margin group.
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UI Element Name Description

Margin Sets the margin property to inherit or (value). If you choose value, enter :
TR T value into the text box and then use the drop-down list to the right to specii
unit of measurement.
ﬂ Custom margin Custom Margin Click the Custom Margin button to open the Margin dialog box. For mor
information regarding the Margin dialog box, see Padding Dialog Box (pa
44).

Margin Dialog Box

The Margin dialog box enables you to specify the width of the padding for the box model. There are five rows in the
Margin dialog box — All, Top, Right, Bottom, and Left — and each row represents an area of the box. Each row allows
you to set the width of the margin in a specific area of the box. For example, setting the property in the All row will
apply the setting to every area of the box, whereas setting the property in the Top row will only add that padding setting
to the top area of the box.

Pl.hrgin

Al - e

Top:

Below the property settings is the CSS Box Model Preview. The preview is provides a preview of how a box and its
elements relate to each other.

To Open the Margin Dialog Box
Complete the following steps:
1. On the Foxy for ASP.NET Ribbon, click the Box tab.
2. Locate the Margin group and then click the Custom Margin button.
The Margin dialog box opens.
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Layout Tab

The Layout tab contains three groups: Layout, Display, and Positioning. From this tab, you can set properties
pertaining to the background of your selected element. The Layout tab appears as follows:

Layout
i float: none = | H overflow: = display; block = |+Z+ postion: - || top:
== clear: both b @ visibility: = | zindex: 0 - || et
Layout Display Posit

The following sections detail the commands of each group.

Layout Group

The Layout group, which resides within the Layout tab (see Layout Tab (page 47)), allows you to specify the
layout of an HTML element. The Layout group appears as follows:

Eﬂnat: none w7 ﬂnver—ﬂnw: w7 :—:-E'=fﬂnat: none ~ ﬂnver—ﬂnw: ~

Layout Layout

The table below details each command in the Layout group.

UI Element Name Description

sip= Float Sets the float property to left, none, right, or inherit.

:J=§ flogt: none -
= Overflow Sets the overflow property to auto, hidden, scroll, visible, or inherit.
3 overflow:

= Clear Sets the clear property to both, left, none, right, or inherit.

&= clear; both -

Display Group

The Display group, which resides within the Layout tab (see Layout Tab (page 47)), allows you to specify the
display and visibility of an HTML element. The Display group appears as follows:

display: block -
& vigibility: 7

Display
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The table below details each command in the Display group.

UI Element Name Description

Display Sets the display property to one of the following:

display: block e o Dtk
inline
inline-block
inline-table
list-item
none
run-in
table
table-caption
table-cell
table-column
table-column-group
table-footer-group
table-header-group
table-row
table-row-group

. inherit
Visibility Sets the visibility property to collapse, hidden, visible, or inherit.

& yisibility:

Positioning Group

The Positioning group, which resides within the Layout tab (see Layout Tab (page 47)), allows you to specify CSS
positioning. The Positioning group appears as follows:

";" position: - ]j top: - | ]j bottom: v |px
| zindex: D - || let: - | [0 right: v |px
Posttioning

The table below details each command in the Positioning group.

UI Element Name Description
+ . Position Sets the position property to absolute, fixed, relative, static, or inherit.
+3* position: -
ZIndex Sets the z-index property to auto or inherit.
N zindesx: 0 “
Top Sets the top property to auto, inherit, or (value). If you choose (value), enter a value
]j top: b L into the text box and then select a unit of measurement from the drop-down list to the
right.
Left Sets the left property to auto, inherit, or (value). If you choose (value), enter a value
:E[ left: ™ | Pee into the text box and then select a unit of measurement from the drop-down list to the
right.
) Right Sets the right property to auto, inherit, or (value). If you choose (value), enter a value
]:[ right: i L into the text box and then select a unit of measurement from the drop-down list to the
right.
Bottom Sets the bottom property to auto, inherit, or (value). If you choose (value), enter a
D bottom: TR value into the text box and then select a unit of measurement from the drop-down list to
the right.
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Background Tab

The Background tab is used to change properties that affect the positioning of an element’s background image.
The Background tab contains three groups - Background Repeat, Background Attachment, and Background
Positioning - and appears as follows:

Background
] 3| 14 [ x: - |px
== [ e =
notepeat repeat repeatx repeaty inhernt fieed  scroll  inherit I‘:I...+ ¥ ~ |p
Background Repeat Background Attachment Background Positioning

The following sections detail the groups residing under the Background tab.

Background Repeat Group

The background repeat group, which appears under the Background tab, looks as follows:

x, [
bt

Y| _'I_—'JE'J
nofepeat repeat repeata repeatsy inhert

Background Repeat

The commands that modify the background-repeat property are as follows:

UI Element Name Description

rfél' No repeat Sets the background-repeat property to no-repeat.

-Jx: Repeat Sets the background-repeat property to repeat.
L: Repeat-x Sets the background-repeat property to repeat-x.
FJ,I Repeat-y Sets the background-repeat property to repeat-y.
'__'i Inherit Sets the background-repeat property to inherit.
]

inherit

Background Attachment Section

The Background Attachment group, which appears under the Background tab, looks as follows:

]
el h5y =,

feeed  scroll inhert

Background Attachment




The commands that modify the background-attachment property are as follows:

UI Element Name Description
3] | Fixed Sets the background-attachment property to fixed.
e
foced
| Scroll Sets the background-attachment property to scroll.
=
scroll
Inherit Sets the background-attachment property to inherit.
[
inherit

Background Position

The Background Position group, which appears under the Background tab, looks as follows:

Background Paositioning

The commands that modify the background-position property are as follows:

UI Element Name Description
. X-Axis Sets the X-axis of the background-position property to center, left, right, inherit,
| = T |Px or (value). If you select value, enter a number into the text box and use the drop-
down arrow to the right to select a unit of measurement.
Y-Axis Sets the Y-axis of the background-pesition property to bottom, center, top, or
[ y: T |Px (value). If you select value, enter a number into the text box and use the drop-down

to the right to select a unit of measurement.

Status Bar

The status bar rests at the bottom of the application and consists of five buttons. The image below provides a
diagram of the Foxy for ASP.NET status bar.

[ DOMInspector [ Custom Zoom

¥ JJ ”|’ﬂ 1002, ()20 OR
Split View LIDDm Slider

Design View
C55

View

The status bar elements work as follows:
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Element

DOMlInspector button

Design View button

CSS View button

Split View button

Custom Zoom button

Zoom Slider bar

Description

The DOMlInspector button is used to turn on inspection of HTML elements. For more information, see Using
the DOMInspector (page 59).

The Design View button allows you to switch to a visual style's WYSIWYG design view. For more
information, see Design Pane (page 23).

The CSS View button allows you to switch to a visual style's CSS view. You can see a visual style's entire CSS
script from this view. For more information, see Design Pane (page 23).

The SplitView button allows you to switch to a view that shows the design view in the top half of the design
pane and the CSS view in the bottom half of the design pane. For more information, see Design Pane (page
23).

The Custom Zoom button opens the Custom Zoom dialog box, which allows you to zoom in and out of
elements in the design pane. For more information, see Custom Zoom Dialog Box (page 51).

In additiom to the Custom Zoom button, you can use the zoom slider bar to adjust the zoom. To adjust the
zoom, click the slider bar's thumb button and then move it right to zoom in or move it left to zoom out. To
zoom in/out incrementally, you can use the zoom in button (-) or the zoom out button (+).

Custom Zoom Dialog Box

The Custom Zoom dialog box allows you to adjust the zoom of the design pane by an exact amount, for example,

125%.

P

Custom foom

Percentage zoom:

125 % =

0K || cancel

To Open the Custom Zoom Dialog Box

To open the Custom Zoom dialog box, click Custom Zoom button on Foxy for ASP.NET status bar.

-

Wisual Styles 55 Properties

Bl =) 100

To Adjust Zoom Using the Custom Dialog Box

Complete the following steps:

1. Click Custom Zoom button on Foxy for ASP.NET status bar.

The Custom Zoom dialog box opens.

2. Complete one of the following:
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3.

o Enter a value into the Percentage zoom field
OR
e  Use the spin buttons to change the value.

Click OK to accept the changes.
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Task-Based Help

The task-based help assumes that you are familiar with CSS fundamentals and have familiarized yourself with the
Foxy for ASP.NET user interface. By following the steps outlined in the help, you will learn how to create, save,
open, import, export, and change the directory of Foxy for ASP.NET projects. You will also learn how to use the
DOMIlnspector to inspect a visual style's object model.

If you haven’t familiarized yourself with the fundamentals of Foxy for ASP.NET or its user interface, we
recommend that you visit the Foxy for ASP.NET Basics (page 13) and User Interface (page 19) sections of this
help.

Creating a Project

In this topic, you will learn how to create a new Foxy for ASP.NET project from an existing visual style.

Note: When you create a new Foxy for ASP.NET project, the project’s files will be automatically loaded into the
default directory at C:\Documents and Settings\[User]\My Documents\C1FoxyVSD (in XP) or
C:\Users\[User]\Documents\C1FoxyVSD\TutorialStyle (in Vista).

From the Welcome to Foxy for ASP.NET Menu
Complete the following steps:
1. Launch the Foxy for ASP.NET application.
2. From the Welcome to Foxy for ASP.NET menu, underneath Getting Started, click New VisualStyle.

Getting Started

@ ) P (%) fl -.{:3" :rl
MNew % Open Irnport Export
VisualStyle VisualStyle Visualstyle Visualstyle

The New VisualStyle dialog box opens.

3. Click the drop-down arrow and select the visual style you want to base your project on. For this example,
select the Arctic Fox style that appears under Included VisualStyles.

4. Complete one of the following:

e Ifyou want to create a project with all of the included controls, leave the Select All check box
selected.

OR

e To choose only one control or to choose several controls, deselect the Select All check box and then
select the box for the control(s) you wish to include in your project

5. Click OK to close the Included VisualStyles dialog box.
From the Foxy for ASP.NET Button
Complete the following steps:
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6.

Launch the Foxy for ASP.NET application.
Click the Foxy for ASP.NET button to open the application menu.

In the application menu, click New.

i \ H 'j iy
| Rece
Mew
I N Y
T DOpen 2l
S ..._u‘dl Vi
L3 5 Import

The New VisualStyle dialog box opens.

Click the drop-down arrow and select the visual style you want to base your project on. For this example,
select the Arctic Fox style that appears under Included VisualStyles.

Complete one of the following:

o If you want to create a project with all of the included controls, leave the Select All check box
selected.

OR

e To choose only one control or to choose several controls, deselect the Select All check box and then
select the box for the control(s) you wish to include in your project

Click OK to close the Included VisualStyles dialog box.

From the VisualStyles Pane

You can create a new project with the full contents of a visual styles folder, which will include every control using
that visual style, or you can create a new project consisting of only one control.

Creating a Project with All Controls

Complete the following steps:

1.

Under Included VisualStyles, right-click the visual style you want to base your project on to open its
context menu. For this example, select ArcticFox.

From the context menu, select Copy to Custom.

A copy of the chosen visual style folder appears under Custom VisualStyles; the new folder is named
ArcticFox-Customl. If you expand the node next to the new style, you will see that it contains several
controls.

Creating a Project with One Control

Complete the following steps:

1.

Under Included ViualStyles, expand the node next to the visual style you want to base your project on.
For this example, select ArcticFox.

The visual style’s node expands, revealing all of the controls that contain that visual style.

Right-click the control you wish to add to your project to open its context menu.
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3. From the context menu, select Copy to Custom.

4. A copy of the chosen visual style appears under Custom VisualStyles; the new folder is named
ArcticFox-Customl. If you expand the node next to the new style, you will see that it contains only the
chosen control.

Opening a Project

You can load a previously saved Foxy for ASP.NET project using the Open dialog box. Any project opened in
this manner will remain in its original directory and not be moved into the default visual styles location. In this
topic, you will learn how to open a visual style project.

From the Getting Started Menu
Complete the following steps:
1. Launch the Foxy for ASP.NET application.
2. From the Welcome to Foxy for ASP.NET menu, underneath Getting Started, click Open VisualStyle.

tting Started
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The Browse for Folder dialog box opens.

3. Inthe Browse for Folder dialog box, navigate to the directory holding the project you wish to load and
then select your project folder.

4. Click OK to close the Browse for Folder dialog box.
The visual style now appears in the VisualStyles pane underneath Custom VisualStyles.
From the Foxy for ASP.NET Button
Complete the following steps:
1. Launch the Foxy for ASP.NET application.
2. Click the Foxy for ASP.NET button to open the application menu.

3. From the application menu, select Open.
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The Browse for Folder dialog box opens.

4. Inthe Browse for Folder dialog box, navigate to the directory holding the project you wish to load and
select the project folder.

5. Click OK to close the Browse for Folder dialog box.

The visual style now appears in the VisualStyles pane under Custom VisualStyles.

Importing a Project

Importing a Foxy for ASP.NET project is similar to opening a project, except that an imported project will be
placed within the Foxy for ASP.NET’s default VisualStyles folder rather than opened from its current directory.
In this topic, you will learn how to import a visual style project.

From the Getting Started Menu
Complete the following steps:
1. Launch the Foxy for ASP.NET application.
2. From the Welcome to Foxy for ASP.NET menu, underneath Getting Started, click Import VisualStyle.
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The Browse for Folder dialog box opens.

3. Inthe Browse for Folder dialog box, navigate to the directory holding the project you wish to load and
select your project folder.

4. Click OK to close the Browse for Folder dialog box.
The visual style now appears in the VisualStyles pane under Custom VisualStyles.
From the Foxy for ASP.NET Button
Complete the following steps:
1. Launch the Foxy for ASP.NET application.
2. Click the Foxy for ASP.NET button to open the application menu.

3. From the application menu, select Open.
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The Browse for Folder dialog box opens.

In the Browse for Folder dialog box, navigate to the directory holding the project you wish to load and
then select the project folder.

Click OK to close the Browse for Folder dialog box.
The visual style now appears in the VisualStyles pane under Custom VisualStyles.

Exporting a Project

You can export a project to another location using the Export VisualStyle dialog box. In this topic, you will learn
how to export a visual style project.

From the Getting Started Menu

Complete the following steps:

1.
2.

3.
4.
5.

Launch the Foxy for ASP.NET application.
From the Welcome to Foxy for ASP.NET menu, underneath Getting Started, click Export VisualStyle.
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The Export VisualStyle dialog box opens.

Click the drop-down arrow and select the project you want to export from the list.

Type in a target path or click Browse to select a location to export the project to.

Click OK to close the Export VisualStyle dialog box.

From the Foxy for ASP.NET Button

Complete the following steps:
1.

Launch the Foxy for ASP.NET application.
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2. Click the Foxy for ASP.NET button to open the application menu.

3. From the application menu, select Export.
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The Export VisualStyle dialog box opens.
4. Click the drop-down arrow and select the project you want to export from the list.

5. Type in a target path or click Browse to select a location to export the project to.

6. Click OK to close the Export VisualStyle dialog box.

Saving a Project

In this topic, you will learn how to save an Foxy for ASP.NET project. In this topic, you will learn how to save a visual
style project.
From the Foxy for ASP.NET Button
Complete the following steps
1. Click the Foxy for ASP.NET button to open the application menu.

2. Click Save to save the current project or Save All to save all opened projects.

From the Quick Launch Menu
Click the Save button Il to save the current project or click the Save All button & to save all opened projects.

Changing the Default Project Location

By default, custom visual styles are saved in the C:\Documents and Settings\[User/]\My Documents\C1FoxyVSD (in
XP) or the C:\Users\[User]\Documents\C1FoxyVSD\ TutorialStyle (in Vista). In this topic, you will learn how to

change the default location of the project.

Complete the following steps:
1. Click the Foxy for ASP.NET button to open the application menu.

2. Click the Foxy Options button.
The FoxyVSD for ASP.NET dialog box opens.
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3. Click Change Default Location.

The Browse for Folder dialog box appears.

4. Complete one of the following:

If you want to change the default location of custom styles to a pre-existing directory, select a folder
and then press OK.

OR

If you want to create a new directory for custom styles, follow these steps:
a. Select the directory you wish to add your new folder to.

b. Click Make New Folder

c. Name the new folder.

d. Click OK to close the Browse for Folder dialog box.

5. Click Save to save your changes and to close the Foxy for ASP.NET dialog box.

Using the DOMInspector

The DOMInspector is used to inspect the document object model tree.
1. Load a Foxy for ASP.NET project.

2. Complete one of the following:

Under the Home tab and in the Editing group, click DOMInspector.
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OR

il

On the status bar, click the DOMInspector button i,

Note: Both of the DOMInspector buttons will glow orange when the DOMInspector is active.

3. In Design view, use your cursor to select an area of the visual style.

The HtmlHierarchy pane displays the element's object model.
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